
 Chapter 5.

Setup Settings

Options on top of options — on top of options…

Grid Web Components have so many choices — Tabular, Form and Stacked Columnar,
Read-only or Updateable, DBF or SQL, Arguments, Filters, Queries, Connection Strings —
to name just a few.

Not to worry, we will put you in control of this balancing act.
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How the material is organized

GRID BUILDER NAVIGATOR The directory on the opposite page and the navigator at left show what you will find
in this chapter. 

•We will learn about Read only and Updateable and discuss the new Version 
10 editing features and templates.

•Grids that are Updateable (or Editable) open another part called Update Set-
tings and we’ll tell you all about it.

•We’ve already done a lot of work with standard grid components, so we’ll 
concentrate on the other types, Form (Columnar) and Stacked Columnar. 
Form has been greatly enhanced for Version 10 and is the most flexible. 
Stacked Columnar is less popular because it can take up a lot of space on the 
page, but we’ve worked up a neat little example that opens some interesting 
possibilities. Accordion containers and a Collapse Bar tuck the Search and 
Grid parts into a such small space you’ll find it hard to believe.

•After that, we’ll tell you about the Grid > Data Source options.

•Then on to the many elements of the Grid Query, including working with a 
View, creating an Argument and using it in a filter, and ordering records.

•Finally, we will touch on Events and Information. 

Preparation for the lesson

The exercises in this chapter should be placed in the MyGridComponentDemo web
project that was created in Chapter 4 (see “Important note” on page 114). Copies of the
completed examples should be in this project.

• The GridComponentDemo web project also has completed examples. File naming 
is discussed on page xi and Web Projects are explained on page 19.

Choosing Read Only or Updateable

One of the first decisions for a component is whether or not it will be updateable. It
can be a determining factor in the type of grid that is used, so we will tackle it first.
There are three places where the decision can be made:

•Component Type page (before fields have been selected). See below.

•Query page. See “Query page read only” on page 178.

•Fields page (after fields have been selected). See “Converting later” on 
page 177.

1. Create a new blank grid component.

•Web Project Control Panel > Web Components > New > Grid > Start with a 
blank Grid Component.

2. Grid Navigator > Component Type page.
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TERMINOLOGY
The question to ask yourself is, “Do I want to allow the user
to edit or add table records and, if so, where is the best place
to do that?” We noted earlier that (1) Update = change field
or record, (2) Insert = add new record and (3) Delete =
delete a record.

•Read only means that none of the above is allowed.

•Updateable means that the end user will be allowed to do 
any or all of the above.

•Only Grids and Detail View parts may be updateable. 
Search parts are just for searching.

IMPORTANT STUFF! If it’s late and you’re falling asleep, splash some water on your face because this next
part is vital to your understanding! The presentation of fields in the Grid is all about
Control Types. 

CONTROL TYPES  Fields can be set up to be one of many control types, the most common of which are
Label and TextBox.

LABEL A Label is static. The field value cannot be changed, as the following Preview test
will show.

3. Grid is: choose Read only.

4. Try to put your cursor in the Grid in the Preview. Can’t be done. 

TEXTBOX A TextBox is dynamic. The field value appears and it can be changed by the user. If
it is blank, data can be entered into it, thus adding to and/or changing the data in the
table. The Preview window illustrates this, too.

5. Grid is: choose Updateable.

•The control type changes to textbox. 

6. Put your cursor in one of the text boxes in the Preview. You can actually

remove the sample text.*

See where we’re going?

READ ONLY Read only means that Alpha Five will set up the Grid or Detail View with Labels.
The user can look at the data, but not change it. Like an airline schedule. You can search
it and look at it, but you certainly can’t change it. In Application Server language, the
data is displayed in a Label control type.

UPDATEABLE Updateable means that the data can be changed, added to or deleted. In this case,
Alpha Five automatically creates TextBoxes in the Grid or Detail View. This control
type permits the user to change his/her address in a Mailing List, for example. You will
still be able to: 

•Allow/disallow record update, insert and/or delete.

• Set up security permissions, as we did in “Restricting column access and 
editing privileges” on page 87.

*. This won’t hurt anything as changes don’t have any effect on the Previews.
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•Use other control types. There are other styles, such as drop down boxes and 
links that can be combined with labels and textboxes.

Converting later
There may come a time when you want to be able to change from read-only to edit-

able. Once you have selected the fields, the option is no longer available at the Compo-
nent Type page. If you try, you will be instructed to go to the Fields section where you
can make the change.

7. Close the new component 
without saving and open 
Editing_Practice.

•This grid has a read-only Detail 
View and fields have been selected 
for both.

•Note the Navigator (red box).

8. Save it as MyEditing.

DETAIL VIEW

9. Click Updateable (red circle).

•The Notice directs you to the Detail View > Fields page.

GRID Our goal is to actually to do the editing in the Grid, not the Detail View. The proce-
dure is the same for both, it’s only the section that is different.

10. Click OK to dismiss the message.

11. Go up to Grid is: and click Updateable (gold arrow above).

•The above Notice appears again, this time directing us to the Grid fields.

12. Click OK again to dismiss the message.

13. Go to Grid > Fields.
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14. Note that the Control Type for the fields is Label.

15. Click the editable? hyperlink above the Selected list.

•The Notice says that if Read Only has been set in the Query 
section, it cannot be changed to Updateable.

NOTE Editable and Updateable are used interchangeably within Alpha Five.

•At first glance, this might be confusing. If you don’t read it carefully, you 
might think they were talking about the Component Type section.

But. There’s another place that Read only can be defined.

QUERY PAGE READ ONLY 16. Navigator > Click Query (DBF).*

•There is a Read only checkbox and a Primary Key button (we’ll get 
into that later).

17. Check Read only. Two things happen:

a. Query page: The Primary Key 
button is removed.

b.  Fields page: The editable option at the top of Fields > 
Selected list is disabled.

18. Uncheck Read only and go back to the Fields page.

•Three things will happen when you check edit-
able? (the next step).

a. The field control types will be changed from 
Label to Textbox (see Results below).

b. The Detail View part will be automatically 
removed (red box at left).

c. An Update Settings section will be added to 
the Navigator (yellow highlight at left).

REMEMBER THIS! If you make your Grid updateable after the fields are selected, the Detail View (if
you have one) will be immediately removed (without confirmation) because an update-
able Grid cannot have a Detail View. 

•To retrieve the Detail View, close out of the component without saving 
changes.

19. Check editable? 

*. This discussion also holds true for SQL databases.
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RESULTS
A notice appears with a list of eligible fields.

•If one or more of the fields is not eligible for change — a 
link or drop down box, for example — it will be excluded 

from the list.* 

•To leave this box, you must do one of the following:

a. To accept all of the fields that are checked by default, 
click OK.

b. If desired, uncheck the fields that are not to be con-
verted and click OK.

In order to leave the Notice dialog, you have to:

a. Make a change and click OK or

b. Click Select None and click OK.

20. Click OK to make all the fields updateable.

21. Save the component. 

•This exercise continues in the next section.

Understanding editing options for updateable grids

• This section continues from the previous one. MyEditing should be open in Design 
mode).

Now that our grid is editable, it’s time
to go over the new editing options for
Version 10. You can either read all
about it or experience the changes for
yourself by choosing the various
options and going to Working Preview
to see the results of each change.

22. Navigator > Update settings.
Scroll down to Editing Properties.

•Note that most of the options are also 
available for an editable Detail View.

DIRTY OR CLEAN No, it’s not time to dump your grid in the bathtub. Dirty and clean are terms used to
describe fields that are or are not in the process of being edited. 

*. Control types are discussed on page 220.
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•“Dirty” fields or rows have changes made that 
have not yet been saved.

•“Clean” ones are unedited and/or have been 
saved.

Field validation setting Do you want validation rules to be applied to all the fields or only those that have
been changed. Options are:

•Dirty fields only (default) or All fields. 

Edit on demand You can choose whether fields are immedi-
ately available for editing or appear at first as
labels and then open for editing when an
action is taken. At left, the row opens for edit-

ing when the pencil is clicked. Options are:

•AllRows (default) or RowOnDemand.

•AllRows has another 
setting.

•Allow individual rows to be saved = Yes (default) or No.

• The default is to allow multiple rows to be edited and saved individually by click-
ing Save in the Row Status Column (see below) or all at once by clicking the Sub-
mit button.

• If you uncheck this option, the Row Status column is removed. Only the Submit 
button is shown and it must be clicked each time to save the record.

a. Row Status column. Click the save button that 
becomes active for a dirty row or press F9.

b. Click the Submit button at the bottom of the dialog

•RowOnDemand 
opens 2 different set-
tings.

•One edit row at a time does just what it says.

•Lazy edits does not query the database to get the current data, so the switch to 
edit mode happens faster. However, if Refresh row on dirty (below) is 
checked, it will refresh as soon as the user starts editing the row.

New records edit style When a grid has a Detail View, it is usually used
for adding new records as we did in “Entering
new records” on page 54. When there is not a
Detail View, new record boxes are added at the
bottom of the grid or you can have them replaced

by a hyperlink in the Navigation Bar.* Options
are:
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•AlwaysShown (default) and ShowOnDemand.

•Show on Demand 
opens two more 
options. 

•Hide new record row after insert (user will need to click the link each time 
he/she wants to add a new record).

•New records button label. Default is New Records.

Abort update if any row has 
error

If any row has a validation error, should the other rows without errors be updated?

•Abort update if any row has error = Yes or No (default).

Error This has to do with the manner in which error messages for records that do not meet

validation* requirements are presented to the user. To understand this, we need to create
a validation rule and then violate it.

23. Grid > Fields: Last_name.

DISPLAY SETTINGS •Validation rules: Click the button.

24. General > Require value = Yes.
(Click OK)

25. Click Working Preview.

26. Remove the value from any Last name and then
press F9, Save or Submit.

27. Place the cursor on the red icon for the message.

There are many ways in which the error message can be defined.

•Error Style: Block, Inline, Tip, Icon (default above) and Global.

•Error Icon: The default icon can be used (above) or another can be selected.

•Show errors in pop-up window = Yes or No (default above)

Go to A5 Video #7 There is a video that explains these options in detail. What’s new in Version 10 >
Web Videos: Error Reporting Styles.

28. Return to Update Settings > Editing properties.

Row refresh method after 
edits

How should the row be refreshed after editing? 

•Auto-select: Let Alpha Five choose the best method (default).

•Full page: Slowest, but assures that all summary fields and linked records are 
refreshed.

•Single row: Only refreshes data in the row.

•Minimal: Fastest, but will not update Summary fields.

*. A hyperlink is the default for Detail View.

*. We’ll talk more about Validation in the next chapter.
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Refresh on row dirty When the user begins editing the row, should an AJAX callback be executed to get

current data?*

•Refresh row on row dirty = Yes (default) or no.

Honor DBF rules Should Alpha Five Field Rules be honored?

•Honor DBF rules = Yes (default) or no.

Editing data with RowOnDemand
We’ll start editing with the Row edit style set to RowOnDemand. The grid will open

with the rows as labels.

29. At Grid > Update settings, make the following changes and accept the
defaults for the rest.

a. Row edit style: RowOnDemand.

b. New records edit style: ShowOnDemand

c. Hide new record row after insert: Yes.

d. New records button label: Click to enter a new record.

30. Click Working Preview.

•Note that there is no submit but-
ton, rows are not open for editing 
and there are no new record rows 
at the bottom of the grid.

SUBMIT BUTTON Governed by: Row edit style.

•AllRows = Button.

•RowOnDemand = No Button.

EDIT, SAVE, CANCEL, DELETE Governed by: Row edit style and Allow individual rows to be saved.

•RowOnDemand. Click the pencil or double click on a row to open editing.

•AllRows > Allow individual rows to be saved.

NEW RECORD ROWS Governed by: New records edit style and Hide new record row after insert.

•AlwaysShown = New record rows at top or bottom of grid (see also “New 
records at top” on page 185).

•ShowOnDemand > Hide new record row after insert.

EDITING 31. Click the pencil to open a row for editing and begin a change.

•The Save and Undo changes buttons become 
active.

32. Click Undo changes or press ESC to
cancel changes. (Click OK to confirm)

*. See “Understanding multi-user editing” on page 186.
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33. Double click on a row to open it for editing.

•Wait a moment for the grid to open. (We occasionally 
experienced a significant hesitation with this method.)

34. Click the black x to cancel edit mode.

35. Click Click here to enter new record.

•Three new record rows reopen. 

36. Enter a new record for Mary Jones and press F9
or click Save.

•The new record rows disappear and the new record is at 
the bottom of the grid.

37. Click the red X to delete the record you just entered
above.

38. At the confirmation dialog, click OK.

•Records can only be deleted one row at a time.

Editing data with AllRows
Next, we will reverse some of the above settings, to open with all rows in edit mode.

39. Return to Design view > Grid > Update Settings: Change as follows.

a. Row edit style: AllRows; 

b. New record rows: AlwaysShown; 

c. Allow individual records to be saved: Yes.

40. Go to Working Preview.

• This time there is a submit button, all rows are open for editing and the new record 
rows are at the bottom of the grid. If it does not appear, see Refresh below.

REFRESH
Sometimes, after changing settings, Working Preview does not
show your properties changes. If that happens, do this:

a. Press F5. You will go to the Preview tab (F5 is the Hot Key for 
that tab as you can see at the left). 

b. Then click Working Preview again (Hot Key = F6).
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DELETE Note also that there is now a Delete column at the right of the grid (gold arrow
above). Multiple records can be deleted by checking them and clicking Submit.

EDITS 41. Make the following edits (check marks above):

•Top record: Change Geoff to Jeffrey; 4th record: Remove the last name; 1st 
new record: Enter MARY.

42. Click the Submit button.

VALIDATE VIOLATION •Because we have violated 
the Last_name required rule 
that we set in step 24 on 
page 181, we get an error 
message.

43. Click OK to dismiss
the message.

CANCEL A CHANGE First, we will resolve the change from Geoff to Jeffrey by cancelling it.

44. Click Undo changes for the first
record (red circle) or press ESC.

45. Click OK at the confirmation dialog.

46. Click the Submit button again.

VALIDATE RULES The Application Server checks validation at both the component level and the Field
Rules level. Component level is always honored. Field Rules are also honored as long as
the following is set.

•Honor DBF rules = Yes (default).

IMPORTANT NOTE Component level rules are honored only in the grid for which they are designed.

47. Click OK.

48. Put your cursor on the
red error ball.

•The error is described.

• For a demonstration see “Go to A5 Video #7” on page 181.

In reality, both of these errors would need to be resolved in order for the user to con-
tinue. We don’t have to do that, however.

49. Click the Design tab and then go back to Working Preview.

•Unsaved records are reset to their original contents.

There are a couple of other settings worth noting while we’re here. 
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HIGHLIGHT ROW Perhaps you have already noticed that the row is highlighted when your mouse hov-
ers over it.

If you look closely,
you will see there are
actually two highlight
levels. The row turns a
bit darker when it is
selected. 

•These settings are located at Properties > 
Layout Options: Highlight on hover and 
Highlight on select. (Defaults = Yes)

NEW RECORDS AT TOP The new record rows don’t have to be at the
bottom of the grid. They can also be at the
top. The setting is located at:

•Update settings > Permissions > New 
record rows position: Top or Bottom.

•Requires that:

•Editing properties > New records edit 
style = Always shown.

Go to A5 Video #3 To see editing in action, go to Help > What’s new in Version 10 > Web Videos >
Editing.

Trapping actions
If a user begins editing a row and then goes to another page without saving the data,

he/she will receive a warning that the edits will be lost if they leave without saving.*

Being consistent
As we said at the outset, there are a lot of choices to be made. We only advise that

you maintain consistency in your application. Unless there is a very good reason, don’t
have a Submit button on one grid and not on another. Don’t allow saving individual
rows on one and not the other. Remember, you probably bought Alpha Five because it
was user friendly. Your users will appreciate your efforts to make it easy on them, too.

And this leads us to another great feature that will help with consistency.

Templates. Coming up next.

*. I suppose your were expecting me to say something about mouse traps here — hey, I don’t want to be too predictable!
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Understanding multi-user editing
    We can’t leave editing, however, without
discussing what happens when more than
one user edits a row at the same time. If your
application is accessed by multiple people,
chances are they will go to the same data on
the same (or similar) grid at the same time.

OPTIMISTIC RECORD LOCKING
    Alpha Five uses a process called Optimis-
tic Record Locking to prevent duplicate
entries at the same time by different users.

A. If Jane begins an edit and
B. John edits and saves first,

C. When Jane clicks Submit, she
will get a write conflict message

that explains the differences in the
values. She can then choose

 the proper one.

•Not to worry — your edits are safe!

Go to A5 Video #5 There’s a great video that shows how this works at Help > What’s new in Version 10
> Multi-user editing.

50. Save and close the component.

Using a grid template to save time and trouble

When you created a grid, you probably noticed the template option. It’s a great new
Version 10 feature that can get you off to a quick start and — our favorite part — help
with that consistency we mentioned above.

To avoid going in and out of this dialog repeatedly, we’ll give an overview of the
options and then use a system template and create one of our own.

1. Create a new Grid component and this time stop at the templates page. 


